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PowerBar/Write--Making Write More Powerful

Windows' Write is not a "power" word processor, and is thus looked at askance by many 
Windows users. But Write's very lack of "power user" features is a virtue--the virtue of 
simplicity. Write makes up in speed, ease of use and convenience (not to mention thrift) what 
it lacks in power and features.

PowerBar/Write gives you toolbar technology for Windows Write, incorporating the most 
useful, commonly used menu features of Write in a buttonbar that's always readily 
accessible. In addition, PowerBar/Write has a utility menu that includes a clock, a file finder 
and opener, a directory creation utility, special characters ("smart" quotation marks, ANSI 
characters, such as ©, ¾ and æ), application launching, time/date stamps, sizing options for 
Write, a printer page orientation toggle, timed automatic file saving, and setup options for 
PowerBar/Write. It starts up Write along with itself, so you don't have to do it. And you can 
even associate your Write files with PowerBar/Write, for instant loading when you use the 
application and Write.

PowerBar/Write was originally written in Visual Basic for Windows 1.0, for Windows 3.1. 
The current version is version 4.5.1, and is written in Visual Basic for Windows 2.0. Visual 
Basic 2.0 brings new speed and smaller compiled file size, so you will notice, if you have 
used previous versions of PowerBar/Write, that it is much faster when loading and in action.

PowerBar/Write 4.5.1 requires:

A 286 or higher CPU running in Standard or Enhanced mode.

A mouse, because most everything in PowerBar/Write is mouse-activated.

The Visual Basic runtime library file, VBRUN200.DLL, in a directory that is on your 
path. (The Windows SYSTEM directory is a good place for it.) If you don't have this 
file, you can usually download it from the same on-line service from which you got 
this file (assuming that was your source) or get it from a friend who uses Windows; 
on-line, look for VBRUN200.EXE or VBRUN200.ZIP. (Note: Do NOT delete your 
VBRUN100.DLL file. It is needed for applications written in Visual Basic for 
Windows 1.0; VBRUN200.DLL does NOT replace this file. If you have 
applications written in both versions, you need BOTH files.)

Windows 3.1 (it will not work properly with 3.0) and Write itself.

PowerBar/Write takes up some real estate on the screen--a vertical strip on the right side 
of your screen, just leftward enough to leave Write's scrollbar uncovered. For many margin 
settings in Write on standard 640x480 VGA (and on laptop computers), this may mean that 
you will be cutting off some of your view of the right margin area of Write. Write's default 
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margins are 1¼" on both sides. PowerBar/Write cuts about ¼" past the right margin; usually, 
at type sizes above 8 pt., Write will wrap words that fall within this ¼" anyway, so it should not 
present a problem if you customarily use Write's default margin. And if you use a higher 
resolution--800x600 or 1024x768, e.g.--you will generally never have any overlap. 
PowerBar/Write is as narrow as a window can be made in Visual Basic.

Installation

PowerBar/Write has one program file, PBWRITE.EXE, and three documentation files. 
Unzip them and put them wherever you want. However, PowerBar/Write must be able to find 
Write itself, so the directory containing Write (most likely your Windows directory) must either 
hold PowerBar/Write also, or be on your DOS path statement in your AUTOEXEC.BAT file. If 
you use Program Manager as your shell, use the standard procedure for installing a new 
launch icon. See the Windows 3.1 User's Guide, pp. 78-83. If you use some other shell or 
nonshell program manager, follow its app installation procedures.

Associating Your Write Files With PowerBar/Write

I strongly recommend that you reassociate .wri files with PBWRITE.EXE instead of with 
WRITE.EXE. The effect is exactly the same: When you open a Write file from an icon, 
command line or file manager, it will be loaded into Write by PowerBar/Write. Use File 
Manager's Associate... command, from the File menu. See the Windows 3.1 User's Guide, 
pp. 131-132; but please note that you should Browse to find and enter the PowerBar/Write 
program name for association. If you set up associations with Notepad by directly editing 
WIN.INI rather than using File Manager, enter PowerBar/Write's entire path in all capital 
letters, and be sure to delete the line associating *.wri files with WRITE.EXE. You will need to 
restart Windows for the new association to take effect.
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How PowerBar/Write Works for You

When you use PowerBar/Write, you do not have to launch Write itself! 
PowerBar/Write will launch Write for you. PowerBar/Write will open up Write, maximized, 
and itself. So you can use the command line for PowerBar/Write in Program Manager instead 
of the Write command line. (You can still use the Write icon, if you like, by changing the icon 
through normal procedures.) If you have associated your *.wri files with PowerBar/Write, 
PowerBar/Write can start up Write and automatically open a file.

In this way, PowerBar/Write is virtually seamlessly integrated with Write; if you associate it 
with your Write files, you can think of it as not another program, but as part of Write. It's the 
easiest way to make Write easier to work with. And the point is to make Write a more 
powerful, more "full-featured" word processor.

If you have the popular Windows shareware spell-checking program WinSpell, and 
if the WINSPELL.EXE file is on your path, PowerBar/Write will start WinSpell when you 
run PowerBar/Write. If you don't have WinSpell, don't worry. PowerBar/Write will simply start 
up without it; there will be no effect on startup. (Note that if you are using WinSpell but are not 
using a registered copy, you will have to get past the "nag" screen in WinSpell. I have no 
association with the makers of WinSpell.)

By default, PowerBar/Write also floats on top of all other application windows, so that it is 
always at the ready when you're working in Write. You can choose, from the Options 
submenu, to sink it or float it.

You'll see a clock (which can be turned off; see below) on PowerBar/Write's menu bar. 
Clicking on the clock will drop down PowerBar/Write's menu.

You can close PowerBar/Write itself by clicking one of the bottom buttons on the bar.

The Buttons on the Bar

The PowerBar/Write buttonbar is mostly self-explanatory. Most buttons correspond to 
menu choices in Write. However, where Write's Document menu uses the phrase "Page 
layout," I have used "Margins." "Fnd" and "Nxt" stand for "Find" and "Find Next," respectively. 
Where Write's Character menu uses words for Bold, Italic, etc., I have used symbols. "+2" 
and "-2" are the Character menu's Enlarge font and Reduce font functions, each having a 2-
point effect on the type selected or following. "N" removes all special type effects except size, 
corresponding to the Character menu's Regular (most word processors, including Microsoft's, 
call this Plain or Normal). L, C, R and J are left-justify, center, right-justify and left- and right-
justify paragraph functions. Norm is a "Normal" paragraph as Write defines that. "Ind" is 
indents. "1," "1.5" and "2" are single, 1½ and double line spacing. The buttons will execute 
their appointed functions just as quickly as Write menu choices. PgBreak enters a hard page 
break a line below the cursor point. XBoth shuts down both PowerBar/Write and Write (you'll 
be prompted to save any changes since the last file save); Xpb shuts down just 
PowerBar/Write.

The Open button simply calls up the Open File dialog, with Write's .wri files as the file 
choices showing. But if you click on the ".txt" button, the Open Dialog will filter the directory 
and show you only text files with the .txt extension; similarly, if you click the ".doc" button 
under the Open button, you will see only .doc files (usually these are Microsoft Word for DOS 
files), and if you click on the "*" (asterisk) button you will see all files. Note: If you use these 
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buttons when you have unsaved changes to a file, PowerBar/Write will either Save the 
file if it has already been named, or prompt you to save it if it has not yet been named; 
but it will prompt you to save in the format you specified with the button you clicked--
which may not be the format you want to save in.

Under the Save and As buttons you'll see two more buttons labelled ".txt" and ".doc." 
Clicking on one of these will prepare you to save a file as a text or Word file. After having 
once saved them in the desired format, you need not use the ".txt" or ".doc" button again; the 
AutoSave function or the Save button will take care of saving, and retain the desired format 
for you.

Underneath the Save ".txt" and ".doc" buttons you'll see buttons labelled "A:" and "B:"; 
these buttons will save your file to drive A: or B:, respectively; if the file is already named, 
they will simply save it named to the floppy drive you select; if it is not yet named, you will 
have to name it. Note that if you use these buttons, but do not also save your file to your hard 
drive as usual, you may end up with differences between the file on floppy and the file on 
hard disk.

Underneath the Undo button you'll see "Sel All" and "Copy All" buttons. "Sel All" 
selects/highlights the entire Write file so that you may perform an operation of your choice on 
the file's entire contents; for example, you might want to select the whole file in order to put it 
all in a specific typeface, or to reduce the whole file in one motion, or to cut the whole file...  
The "Copy All" button selects the whole file, again, and then copies it to the Clipboard, for 
pasting into another application or file.

If Write Is Not Running  If you attempt to use the buttons on the bar or a menu item while 
Write is not running, PowerBar/Write pops up a dialog box that asks whether you want to start 
Write. The exceptions are the New and Open buttons, which automatically start Write if you 
click either of them while Write is not running; the New button opens Write to a blank file, and 
the Open button does the same, but also calls up the File Open dialog.



Powerbar/Write            5

The Clock Utility Menu

The Clock Menu  PowerBar/Write opens up with a clock where a menu heading would 
normally be expected. Clicking on the clock drops down the Utility menu, just as if there were 
a normal heading. You can turn the clock off and back on in the menu's Options submenu. 
When the clock is off, the menu heading becomes "Utility."

Magic Menu Trick  There is, above the "New" button, a little button with a minus sign on 
it. If you click on this, it will change to a plus sign. Then, if you bring your pointer up to the 
menu at anything less than breakneck speed, you should notice an interesting phenomenon: 
The menu will drop down without your having to click on the clock (or the menu heading, 
"Utility"). This doesn't mean you can't click on it, if you like, but you may find it handy to have 
it drop down like this. PowerBar/Write does NOT have to be the active application for this to 
work.

This is a "trick"--it is not standard Windows behavior; in fact, there is no way to really 
make a menu, per se, do this. The trick is to get another part of the program's interface to do 
it. Notice the little title box beneath the menu bar. That title box is the object that activates the 
menu. When you pass over the title box, it tells PowerBar/Write to drop the menu down. But if 
you come into the menu too fast, or from above, or from the side, the title box will not sense 
the mouse passing over it, and will not trigger the menu.

As I said, this is not standard Windows behavior, and I'm usually a real stickler for sticking 
to Windows conventions. Still, I've seen this trick in DR DOS's graphical file manager's 
menus, and it can be added to the Mac system; it seems like a pretty good idea to me, so I 
added it here. If you don't like it, simply click the "+" button; if you like it, you can turn it on in 
each session. (I'll probably include the ability to save it in the on or off position with the next 
version of PowerBar/Write.)

File Finder  A file search, open and deletion utility. The utility box will pop up on your 
screen ready to use. It consists of:

A file filter setting. The default setting is *.wri, to search for Write files. But you can 
change it to search for any filename or extension you wish. (Enter filespecs only 
here--filename and/or extensions, including wildcards; do not enter directories or 
drives.)

A drive drop-down list. You can change the drive you wish to search here.
A directory list. Here you can travel through the directory structure of the disk and drive 

you want to search; double-click on the target or initial subdirectory.
A matching list box. This will list all the files that match your mask.
Command buttons. These start and halt searches, open a selected file, delete a 

selected file and exit the search box.

To search for a file, set up the filter, and if necessary the drive and initial directory, then 
click the Start Search button or press AltS. The searcher will move through the designated 
directory and its subdirectories to find all the files that match the mask you set up. (To search 
an entire disk, specify its root directory.) Matching files will be listed in the box on the right of 
the File Search window. You can stop a search in progress if, say, you already see what you 
need; just click the Quit Search button or press AltQ.

To open a file, note the condition of the file you're working on currently, if there is a file 
open: Has it been saved--ever, or lately, or does it have changes you'd just as soon dispose 
of? PowerBar/Write can either save your most recent, unsaved changes and then open the 
selected file, or discard the most recent changes before it opens the selected file. If you are 
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opening in place of an unused file, or in place of a file that has not changed since it was last 
saved, either button will open the selected file without error. Select the filename you want to 
open, and then click the appropriate button.

PLEASE NOTE: If the file you are using has not been saved even once, do not use the File 
Searcher's button option to save the file; PowerBar Write cannot finish its open operation 
by itself if you try to use it on a never-saved file. So first save the file through the buttonbar. 
Alternatively, you can go ahead and use the save button, but you will be prompted as to 
whether or not you want to overwrite the file you're trying to open; answer NO. You'll note that 
that file name now appears in the Save As... dialog's filename space; simply overtype the 
new file's new name, and press Enter; then, when the file open dialog pops up, enter the keys 
Shift Ins or Ctrl V and Enter to open the file you wanted opened.

To delete a file, first use the Search function; then simply select the file you want to delete 
by clicking on it once and then click on the "Delete selected file" button. You will be prompted 
to approve the deletion.

Make Directory  This little utility gets you into creating a directory FAST. Note that you 
need only enter the directory name, and you must follow DOS conventions for naming. If you 
try to create a name longer than 8 characters plus dot and 3 characters, or longer than 8 
characters without a dot and extension, the Make Directory utility will automatically trim the 
name down to DOS acceptibility. (You may not like the name that results, so just do it right 
the first time.) You can search back through the directory and drive lists to verify that the 
directory has been made, but really, you can trust it pretty well. And yes, it will only make 
directories on the A:, B:, C:, D: and E: drives.

AutoSave Submenu  With this submenu you can choose a new timed AutoSave interval, 
or turn off AutoSave altogether. The default is On with a 5-minute interval between saves.

PLEASE NOTE: PowerBar/Write's AutoSave will activate according to the specified interval even 
if you are working in an application other than Write, so if you are going to do so and don't 
want to have PowerBar/Write abruptly take you away from your work (or play) by popping 
back to save the Write file, you should turn off AutoSave before going on to another 
application.

Character submenus  On these four submenus you will find an extensive selection of 
ANSI special symbols and characters that are frequently used in business and academic 
documents. Put the I-beam insertion point where you want the character to appear, drop 
down to the desired character on one of PowerBar/Write's four character submenus and 
release. The character will appear in your Write document.

“Smart quotes” are true, typefont-style quotation marks, rather than the plain straight 
quotation marks that Windows uses by default. Smart quotes simply look better. You can 
create them one at a time from the menu, to suit your current needs. Or you can choose 
pairs, and PowerBar/Write will create the pair and then put your insertion point between the 
marks--automatically preparing you to quote away. Spiffy, huh? Please note that not all fonts 
support "smart quotes."

The Optional Hyphen is an undocumented character that Write is capable of producing. It 
is essetially a "disappearing" hyphen. Write will not automatically or intelligently hyphenate 
words, as some high-end word processors will. However, it will let you insert an optional 
hyphen where you want in a word. This optional hyphen will only show up if the word is near 
the end of the line it's typed on; then the word will break at the hyphen, rather than carrying 
over whole to the next line. If you later edit text and move the word back in the line or forward 
to the next, the optional hyphen will disappear; but it will still be there invisibly (which means it 
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will take up a character space, with respect to moving the insertion point with the arrow keys), 
and if the word again gets pushed to the point where it would, without the hyphen, flow to the 
next line, it will hyphenate instead (as long as the hyphen falls near enough to the beginning 
of the word to still fit inside the margin). (You can have more than one optional hyphen in a 
word.) You can also enter the optional hyphen character from your keyboard, directly in Write, 
by pressing CtrlShift and the hyphen key. This is easier than using PowerBar/Write to insert 
the character, except that you have to remember the keys.

The Numeric menu uses captions like "e²" and "x°"; however, when you select these 
characters, only the symbol--i.e., "²" or "°"--will appear. In the Marks/Symbols menu, the two 
bullet characters are difficult to see--or, rather, the small one is difficult to see and the large 
one cannot be reproduced by Windows' menu font as a bullet; thus their captions include 
SmBlt and LgBlt. Not all typefaces have bullets or full ANSI character sets; you may find that 
choosing one of these characters inserts a square, a space or a vertical block into your 
document; if so, select it and put it in another face, such as Windows' TimesNewRomanPS, 
that has the bullet or ANSI character you need.

Time/Date Stamps  This submenu gives you 12 different time and date stamps for 
immediate entry into your text at the cursor insertion point.

Runners  A submenu that lets you start several Windows applications that can be useful 
when working with word processor files. In addition, Run... will pop up a Run... dialog into 
which you can enter a command line or associated file name. If you use Program Manager or 
File Manager as your Windows shell, choosing the shell from the menu will restore and 
activate its window, not run a second instance of either. The DOS session is a full-screen 
session, not windowed.

Options  This breaks into a submenu with six more sections. It'll be clear what they do 
from reading the menu. PowerBar/Write's defaults for these options are:

Write is maximized.
The PowerBar floats.
The PowerBar is in its original position, at the top of the screen and just to the left of 

Write's vertical scroll bar.
The menu clock is on.
Write sets the printer in Portrait mode.

Exits  Exit Write & PB/W closes both Write and PowerBar/Write. Exit Windows closes 
Windows. You will be prompted to save any changed files before anything closes, so these 
are safe exits.

HOTKEYS IN POWERBAR/WRITE  The menu hotkeys in PowerBar/Write are there for the 
convenience of users who like to use the keyboard most of the time. If you are one of these 
users, you'll become adept at cool-switching to PowerBar/Write by AltTabbing, then hitting the 
hotkeys you've memorized to make the changes that you desire in the program. I've tried to 
make the hotkeys have something to do with the menu command they execute, in most 
cases, but I haven't tried to follow any standard such as Microsoft Word, because this 
program is nothing like any standard Windows mega-application.

Fooling PowerBar/Write

PowerBar/Write can be fooled, because it is not fully system-aware. Thus if you change the printer orientation 
from Write's menu options rather than from PowerBar/Write's Options submenu, the Options submenu status check 
may not indicate the true orientation of the printer. Similarly, if you resize Write from its own system menu or sizing 
buttons, or if you run multiple copies of Write or open another copy of Write from the runners menu, either along with 
the original startup copy or after closing down a startup copy, PowerBar/Write's Write size indicator checks may be 
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wrong for the particular copy you are working in. These inaccuracies, however, will not cause malfunctions, and 
using the PowerBar/Write options will execute functions properly and update immediately (in the case of size, for the 
copy you update only). But you should know that there are these possibilities; if you use the Options menu 
exclusively for these functions you'll almost always find PowerBar/Write to accurately reflect the state of Write.

"Why Can't I Save Settings?"

If you prefer an alternative set of defaults, PowerBar/Write has no way to save them. Why? This was a decision 
based on expressed dislikes of many Windows users. Windows and Windows applications are big programs. Making 
them capable of saving settings makes them much bigger, or adds files to your hard disk--usually some kind of 
initialization (.INI) file--or requires writing a new section into WIN.INI. I purposely decided against these options, 
because I want to keep PowerBar/Write as compact as possible and as neat as possible. Which means I don't want 
to dot your hard disk with extra files or mess around with your Windows .ini files.
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Registration/Purchase

PowerBar/Write is shareware; as usual, please limit your unregistered use to a maximum 30-
day trial period. If you like and use PowerBar/Write regularly, please register it. This gets you 
the following: The feeling that you've gotten something for your money, which is almost 
always superior to feeling that you've gotten away with something. The knowledge that you're 
encouraging ideas and better programming in the future. Perpetual license to subsequent 
editions of PowerBar/Write. And if you pay the higher registration price, automatic updating to 
the next version by mail.

Prices:
$10 -- Standard registration license: Registers PowerBar/Write for use on any three 
computers, and I don't care whose--pass it to two friends, put it on a desktop at home, a 
notebook and a desktop at work--you choose. (With the exception that you cannot 
assume that someone else, unknown to you, has registered the program without using up 
all his or her rights to three installations; this is a personal license for you and two others 
you choose, and unless you were chosen, and received from the chooser a copy of the 
license, you are not registered for legal post-trial period use.) You'll receive a digital 
license by mail. Registration is perpetual; I don't expect you to pay for a higher-numbered 
version of PowerBar/Write once you've paid for it once. But you're on your own as to 
finding future versions. (If you got this program from America Online, please send only 
the $10 registration fee if you think you'll be keeping your AOL account. AOL always gets 
the earliest upload of new versions of PowerBar/Write and other programs by the same 
author.)

$15 -- Same as standard registration, except that I'll send you the next major update by 
U.S. mail, or America Online, by electronic mail.

For an additional $5, added to either the $10 or the $15 registration, you can get the 
Visual Basic code for PowerBar/Write.

[A note to magazine reviewers about registration price: Please note that the $10 
registration price does NOT cover shipping and handling. In reviews, please list the 
registration price as $10 plus, if ordered by mail, $5 for shipping and handling.]

Send check or money order payable to David Stewart, or, if you want to risk it, cash, and 
the name of the bulletin board or other source from which you got this program, as well as 
comments, complaints, compliments, ideas for improvements or additions, to:

David Stewart
738 Hathaway Drive

Auburn Hills MI 48326

For your convenience, there's a registration form included in the .zip file from which you 
extracted this program; use that to register.

Upload/Shareware Catalog/Disk Distribution Notice
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The upload policy is very simple: Please upload this program to as many services as 
possible, and distribute at users' groups, and do anything else you like to get it 
around. Just be sure to distribute all files. And thanks!

If you distribute a shareware catalog of any sort, or compile disks of shareware for sale, 
or for inclusion in books, you have express permission to include PowerBar/Write or other 
applications by this author in the publication or on the disks (PLEASE!), as long as all original 
files included with the .zip source file are included, and as long as no charge is made beyond 
a reasonable one for running a business, distribution and profit, and as long as the software 
is not represented as "free" software, or as if the price of distributing disks were a substitute 
for registration fees.

Technical Support

I can hardly think of anything you'd need support for, but if you find a problem, you can 
write to me, David Stewart, at the above address, or you can drop me a line on Prodigy, ID  
CTKJ00D (those are zeros between the J and D), or America Online, name Doc Yeah (look 
for me on-line, too; I don't mind helping live by Instant Message or private room). 
CompuServe members, as well as members of many other InterNet services, can send mail 
via the mail gateway between such services and America Online. If you really need help like 
NOW, you can get my phone number by calling Directory Assistance in the 313 area code. 
But EMail is preferred.

About the Programmer

David Stewart is an advertising copywriter, a widely published free-lance writer, reviewer and editor and now a 
learning programmer. He is working on a book on radically customizing Microsoft Windows--far beyond the Control 
Panel and WIN.INI and SYSTEM.INI settings.

If you want your programs or products or company to have a sophisticated advertising program, but can't afford an 
agency, or you would like to give your documentation or any other writing the touch of a professional writer or editor, 
contact him at the address above, on Prodigy or America Online, or by phone: call directory assistance at 1-313-555-
1212 and ask for David Stewart in Auburn Hills.
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Man, I hate this part. Just like the big software companies, I disclaim all responsibility for effects of the use of PowerBar/Write. All warranties, either express 
or implied, including but not limited to fitness  for any particular purpose other than interacting with Windows Write are disclaimed. Nor will David Stewart or 
Argyle Softstuff be liable for any damages whatsoever arising from the use of this program. Let's keep the lawyers out of this: If you have a problem, let me 
know.


